Contents

Preface........................................................................................................................................................................ 1-v
Audience......................................................................................................................................................................... 1-v
Related Documents...................................................................................................................................................... 1-v
Conventions .................................................................................................................................................................. 1-v

Chapter 1
Installation and Configuration......................................................................................................................................... 1-1
Overview........................................................................................................................................................................ 1-1
Installation...................................................................................................................................................................... 1-2
WebLogic Configuration .............................................................................................................................................. 1-2
Installing and Configuring MapViewer (mvclient.jar)................................................................................................. 1-18
OUBI Configuration..................................................................................................................................................... 1-21
Admin Tool Theme Profile Configuration Options.................................................................................................. 1-21
Configuring Column, Table, and Report Labels........................................................................................................... 1-29
Setting up a Third-Party Base Map............................................................................................................................ 1-31
Importing Map Data from Shapefile.............................................................................................................................. 1-32
Configuring Weather Bug Data................................................................................................................................... 1-33
Spatial Configuration.................................................................................................................................................... 1-34
Installing US State Spatial Data.................................................................................................................................... 1-34
Installing US City Spatial Data .................................................................................................................................... 1-35
Installing US Zip Code Spatial Data ............................................................................................................................ 1-36
Installing US County Spatial Data................................................................................................................................ 1-37
Configuring NMS Device Spatial Data.......................................................................................................................... 1-38
Loading Spatial Metadata.............................................................................................................................................. 1-40
OBIEE Configuration................................................................................................................................................... 1-40
Setting Up and Configuring User Security.................................................................................................................. 1-41
Managing Content in the Presentation Catalog......................................................................................................... 1-42
Configuring the Repository (RPD) File............................................................................................................................ 1-43
Loading Catalog Files.................................................................................................................................................. 1-46
Database Configuration................................................................................................................................................... 1-47
Creating Materialized Views........................................................................................................................................ 1-47

Support
Contacting Oracle Support............................................................................................................................................ 1-52
Preface

This guide describes how to install and configure Oracle Utilities Advanced Spatial and Operational Analytics.

Audience

This guide is intended for anyone interested in understanding or performing the process of installing or configuring Oracle Utilities Advanced Spatial and Operational Analytics.

Related Documents

Oracle Utilities Advanced Spatial and Operational Analytics User Guide
Oracle Utilities Business Intelligence Documentation Library:
  Oracle Utilities Business Intelligence Release Notes
  Oracle Utilities Business Intelligence Quick Install Guide
  Oracle Utilities Business Intelligence Installation Guide
  Oracle Utilities Business Intelligence DBA Guide
  Oracle Utilities Business Intelligence User Guide
  Oracle Utilities Business Intelligence Server Administration Guide
  Oracle Utilities Business Intelligence Batch Server Administration Guide
Oracle Business Intelligence Suite Enterprise Edition Documentation Library
Oracle Utilities Application Framework Business Process Guide
Oracle Utilities Application Framework Administration Guide
Oracle Utilities Network Management System Documentation Library

Conventions

The following text conventions are used in this document:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.</td>
</tr>
<tr>
<td>Convention</td>
<td>Meaning</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>italic</td>
<td>Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.</td>
</tr>
<tr>
<td>monospace</td>
<td>Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.</td>
</tr>
</tbody>
</table>
Chapter 1
Installation and Configuration

This chapter provides instructions for installing and configuring Oracle Utilities Advanced Spatial and Operational Analytics.

Note: Oracle Utilities Advanced Spatial and Operational Analytics is built on top of Oracle Business Intelligence Enterprise Edition 10.1.3.4.1 and Oracle Utilities Business Intelligence v2.3.0. Please complete all installation steps for those products before you begin installing Oracle Utilities Advanced Spatial and Operational Analytics.

For installation and configuration tasks relating to Oracle Business Intelligence Enterprise Edition, please refer to the Oracle Business Intelligence Suite Enterprise Edition installation documentation. For installation and configuration of Oracle Utilities Business Intelligence, refer to the Oracle Utilities Business Intelligence installation documentation. See Related Documents for a list of all available documents and the product library to which each document belongs.

This chapter includes the following major topics:
- Overview
- Installation
- OUBI Configuration
- Spatial Configuration
- OBIEE Configuration
- Configuring the Repository (RPD) File

Overview

Oracle Utilities Advanced Spatial and Operational Analytics comprises a set of answers and dashboards that are built on top of Oracle Business Intelligence Enterprise Edition and Oracle Utilities Business Intelligence v2.3.0.

Oracle Utilities Advanced Spatial and Operational Analytics consists of the following products:
- Oracle Utilities Outage Analytics (non-spatial data)
- Oracle Utilities Advanced Spatial Outage Analytics

Oracle Business Intelligence Enterprise Edition built-in metaphors are utilized to display non-spatial information in tables, bar graphs, pie charts, and gauges. For spatial analytics, Oracle MapViewer technology is integrated with Oracle Business Intelligence Enterprise Edition to display events, weather data, and other information that is geographically related.
Installation

This section provides installation and configuration information relating to WebLogic and MapViewer.

WebLogic Configuration

This section describes how to configure the system for WebLogic. It contains the following topics:

- Creating a WebLogic Domain in Windows
- Creating a WebLogic Domain in Unix & Linux
- Deploying to a WebLogic Application Server
- Configuring and Deploying MapViewer

Creating a WebLogic Domain in Windows

Use the following procedure to create a WebLogic domain in Windows:

1. Launch the WebLogic Configuration Wizard from Start->Programs->Oracle WebLogic ->Tools.
2. On the Welcome page, select Create a new WebLogic Domain and click Next.
3. On the Source Domain Page, select Generate a domain configured automatically to support the following products: Basic WebLogic Server Domain. Click Next.
4. On the Specify Domain Name and Location page, enter a domain name and click Next.
5. On the Configure Administrator User Name and Password page, enter a password for the Administrator.
6. On the Configure Server Start Mode and JDK page (see following figure), select Production Mode and Sun JDK and click Next.
7. On the Select Optional Configuration page, check the Administration Server checkbox and click Next.

8. On the Configure the Administration Server page, modify the Administration Server settings (Server Name, Listen Address and Port, SSL Listen Port, and SSL enabled) as needed.

9. On the Configuration Summary page, review the information and click Create.

10. On the Creating Domain page, click Done when the setup is complete.

11. Configure the heap size in %DOMAIN_HOME%/bin/setDomainEnv.cmd, where %DOMAIN_HOME% is the directory in which the above domain was installed.

   Change the following:
   
   if "%JAVA_VENDOR%"=='Sun' {
       set WLS_MEM_ARGS_64BIT=-Xms256m -Xmx512m
       set WLS_MEM_ARGS_32BIT=-Xms256m -Xmx512m
   }

   to:
   
   if "%JAVA_VENDOR%"=='Sun' {
       set WLS_MEM_ARGS_64BIT=-Xms512m -Xmx1024m
       set WLS_MEM_ARGS_32BIT=-Xms512m -Xmx1024m
   }

12. Start the new WebLogic domain, either from the start menu or by running %DOMAIN_HOME%/startWebLogic.cmd.

13. If Oracle Utilities Advanced Spatial and Operational Analytics is installed, change %DOMAIN_HOME%/bin/setDomainEnv.cmd from:

    @REM ADD EXTENSIONS TO CLASSPATHS
    set EXT_PRE_CLASSPATH=

    to:

    @REM ADD EXTENSIONS TO CLASSPATHS
    set EXT_PRE_CLASSPATH=C:\bea\modules\bl\source\config

    where C:\bea is %BEA_HOME%, the directory where WebLogic was initially installed.
14. Deploy the analytics.war (Refer to **Deploying to a WebLogic Application Server** for details.)

**Creating a WebLogic Domain in Unix & Linux**

Use the following procedure to create a WebLogic domain in Unix or Linux:

1. Change directory to `$BEA_HOME/wlserver_10.3/common/bin` and run `config.sh`:

   ```bash
   # cissys@sf-hpa02 /spl/middleware10.3.3/wlserver_10.3/common/bin
   #> ./config.sh
   Unable to instantiate GUI, defaulting to console mode.
   ```

   The configuration wizard is displayed.

2. On the Welcome page, choose option 1 to create a domain and press Enter.
3. On the Select Domain Source page, choose option 1, Choose WebLogic Platform Components, and press Enter.

5. On the Edit Domain Information page, enter the domain name and press Enter.

7. On the Select the Target Domain Directory page, enter the location for Domain Home and press Enter.

8. On the Configure Administrator User Name and Password page, enter 2 to set the WebLogic Administrator Password, then press Enter.
9. Enter the password and press Enter.

10. Enter 3 to confirm the password and press Enter.
11. Reenter the password and press Enter.

12. Press Enter to continue to the next screen.
13. On the Domain Mode Configuration page, enter 2 for Production Mode and press Enter.

14. On the Java SDK Selection page, select a relevant Java Software Development Kit (JDK). For Linux & Solaris, use Sun JDK. For AIX use IBM JDK and for HP-UX, use HP Software Development Kit.
15. On the Select Optional Configuration page, enter 1 (Administration Server) and press Enter.

16. Press Enter to continue to the next screen.

17. On the Configure the Administration Server page, configure the AdminServer’s port, if needed.

18. Press Enter to continue to create the domain. When completed, the screen displays the message: Domain Created Successfully.
19. Edit $DOMAIN_HOME/bin/setDomainEnv.sh to increase the default heap size. Set the minimum to 256MB and the maximum to 1GB.
   For example, change:
   
   ```bash
   if [ "${JAVA_VENDOR}" = "Sun" ] ; then
       WLS_MEM_ARGS_64BIT="-Xms256m -Xmx512m"
       export WLS_MEM_ARGS_64BIT
       WLS_MEM_ARGS_32BIT="-Xms256m -Xmx512m"
       export WLS_MEM_ARGS_32BIT
   to:
   
   if [ "${JAVA_VENDOR}" = "Sun" ] ; then
       WLS_MEM_ARGS_64BIT="-Xms512m –Xmx1024m"
       export WLS_MEM_ARGS_64BIT
       WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"
       export WLS_MEM_ARGS_32BIT
   
20. Prepend the classpath with the location of config.properties file.
    For example, change:
    
    ```bash
    # ADD EXTENSIONS TO CLASSPATHS
    EXT_PRE_CLASSPATH=
    ```
    to:
    
    ```bash
    # ADD EXTENSIONS TO CLASSPATHS
    EXT_PRE_CLASSPATH="/spl/middleware10.3.3/modules/b1/source/config"
    export EXT_PRE_CLASSPATH
    ```
Deploying to a WebLogic Application Server

Use the following procedure to deploy Oracle Utilities Advanced Spatial and Operational Analytics to a WebLogic application Server:

1. Go to WebLogic Administration Console using the url http://<hostname>:<adminserver port>/console
2. Log in using the WebLogic Administrator credentials entered during installation.
3. Click on Deployments.
4. Click the Install button.
5. Browse for the `analytics.ear` file and click **Next**.

6. On the Choose Targeting Style screen, select **Install this deployment as an application** and click **Next**.

7. In the Select Deployment Targets screen, click on **AdminServer** then click **Next**.
8. In the Optional Settings screen, accept the defaults and click **Finish**.

9. In the Summary of Deployments screen, choose ‘analytics’ and click on **Start** drop-down. Then select **Servicing all requests**.
Configuring and Deploying MapViewer

This section is only applicable for Oracle Utilities Advanced Spatial Outage Analytics (OUASOA).

1. Unzip the contents of the OUASOA Pack into a temporary directory, $TMP_BIRDSEYE
2. Expand mapviewer.ear file into $OBIIE_HOME/web/mapviewer.
3. Expand $OBIIE_HOME/web/mapviewer/web.war into $OBIIE_HOME/web/mapviewer/web.
4. Copy all the files in $TMP_BIRDSEYE/web/mapviewer/fsmc to $OBIIE_HOME/web/mapviewer/web/fsmc.
5. Copy all the files in $TMP_BIRDSEYE/web/mapviewer/web/WEB-INF to $OBIIE_HOME/web/mapviewer/web/WEB-INF.
6. Edit $OBIIE_HOME/web/mapviewer/web/WEB-INF/conf/mapViewerConfig.xml and populate it with appropriate data source. For example:

   ```
   <map_data_source name="BYADM"
    jdbc_host="sf-pdwin-14"
    jdbc_sid="Oracle Utilities Advanced Spatial Analytics"
    jdbc_port="1521"
    jdbc_user="BYADM"
    jdbc_password="!byadm"
    jdbc_mode="thin"
    number_of_mappers="2"
    allow_jdbc_theme_based_foi="true"
    />
   ```

7. Copy $TMP_BIRDSEYE/b1/config/config.properties to $BEA_HOME/modules/b1/config/config.properties, creating the directories if necessary.
8. Edit $BEA_HOME/modules/b1/config/config.properties and ensure it has the correct database information.
9. If the WebLogic instance is not already up, start it.
10. Log into WebLogic Console through the url used to deploy analytics.ear.
11. In the Domain Structure panel, click Deployments.
12. In the Deployments section, click Install.
13. Browse and select the MapViewer directory, then click **Next**.

14. In the Choose Targeting Style section, select **Install this deployment as an application**, then click **Next**.

15. In Select Deployment Targets screen, choose **AdminServer**, then click **Next**.

16. In Optional Settings screen, do not change anything and click **Finish**.
17. After the application is deployed, click on the check box next to MapViewer, and select **Start->Servicing all requests** (see following figure).

![Image of MapViewer Configuration](image.png)

**Installing and Configuring MapViewer (mvclient.jar)**

This section describes how to install Oracle Fusion Middleware MapViewer specifically for Oracle Utilities Advanced Spatial and Operational Analytics.

1. Download the latest Oracle Fusion Middleware MapViewer (currently the latest is version 11.1.1.2):


2. Extract the content of the download file (mapviewer1112.zip) under C:\ directory.

3. Extract the mapviewer ear file, as shown below:

   **Note:** You will need to search for the mapviewer.ear file within the mapviewer1112.zip file before extracting it in c:\mapviewer.
After extracting, the .ear file should appear in the mapviewer directory as shown below:

4. Rename mapviewer.ear to mapviewer1.ear. The files should appear as shown below:

5. Copy all the necessary files needed for Oracle Utilities Advanced Spatial and Operational Analytics from your install package.
   - Copy oraGeoMap.jsp to mapviewer\mapviewer.ear\web.war\fsmc directory
   - Copy oraGeoMap.css to mapviewer\mapviewer.ear\web.war\fsmc\css directory
   - Copy the following to mapviewer\mapviewer.ear\web.war\fsmc\jslib directory
     - AwsJSONRequest.js
     - AwsOracleMapManager.js
     - obiec_mapping_inc.js
     - oraGeoMap.js
     - table_accordion.js
   - Copy the following to mapviewer\mapviewer.ear\web.war\fsmc\images directory
     - infoicons/b1_close_ena.png
     - infoicons/b1_overflow_left_ovr.png
     - infoicons/b1_overflow_right_ovr.png
     - b1_btn_clear.gif
6. Update mapviewer\mapviewer.ear\web.war\WEB-INF\conf directory. Refer to this file for suggested settings:

mapViewerConfig.xml

7. Define the following:
• If using oracle proxy add the following:
  `<web_proxy host="www-proxy.us.oracle.com" port="80" />
• If there is proxy used, insert the following in the security_config node.
  `<proxy_enabled_hosts>
elocation.oracle.com, maps.weatherbug.com, direct.weatherbug.com,
  api.wxbug.net, dev.tiles.weatherbug.com
  </proxy_enabled_hosts>
• Add the following ns_data_provider node
  `<ns_data_provider id="obieeNsdp"
    class="com.oracle.utilities.birdseye.BirdseyeNSDP" />
• Replace the current map_tile_server with the following map_tile_server node
  `<map_tile_server>
    <tile_storage default_root_path="/mytilecache/"/>
  </map_tile_server>
• Define the datasource. For example:
  `<map_data_source name="bi230dev"
    jdbc_host="sf-lindb-10.us.oracle.com"
    jdbc_sid="bi230dev"
    jdbc_port="1521"
    jdbc_user="dwadm"
    jdbc_password="!<password>"
    jdbc_mode="thin"
    number_of_mappers="3"
    allow_jdbc_theme_based_foi="true"
  />

  **Note**: The password after the ! special character will be encrypted after saving.

8. Copy the following to mapviewer\mapviewer.ear\web.war\WEB-INF\lib directory:
OUBI Configuration

This section contains information about configuring Oracle Utilities Business Intelligence (OUBI) for use with Oracle Utilities Advance Spatial and Operational Analytics. It contains the following topics:

- Admin Tool Theme Profile Configuration Options
- Configuring Column, Table, and Report Labels
- Setting up a Third-Party Base Map
- Importing Map Data from Shapefile
- Configuring Weather Bug Data

Admin Tool Theme Profile Configuration Options

Several map themes can be created, requiring a collection of attributes (option types). The Admin Modules Map Theme Profile supports a considerable number of Theme Profile Options types that can be configured to create a map theme. Two types of themes can be created:

- Non-Spatial Data Provider (NSDP) Themes
- Weather Themes

The Theme Profile Options screen is shown in the following figure:
NSDP Themes

The following table lists the option types available when creating NSDP Themes:

<table>
<thead>
<tr>
<th>Parameter Attribute</th>
<th>Description</th>
<th>Value Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Column</td>
<td>The column in the spatial table that uniquely represents a spatial location. It is normally the field representing the geographical name such as county, state and city.</td>
<td></td>
</tr>
<tr>
<td>Geography Key Column</td>
<td>The column in the answers that will be used to join to Key Column defined above.</td>
<td></td>
</tr>
<tr>
<td>Value Column</td>
<td>The column in the answers that will represent the value in rendering the map theme</td>
<td></td>
</tr>
<tr>
<td>Theme Name</td>
<td>The theme name to be used. The theme name must be defined using Oracle Map Builder.</td>
<td></td>
</tr>
<tr>
<td>Render Style</td>
<td>Optional. The render style to be used for the defined theme. If not specified, then the render style directly defined in the theme is used. You can also place an optional “big” or “small” value delimited by</td>
<td></td>
</tr>
<tr>
<td>Example: birdseye.V.CUST_INTER_1 birdseye.V.CUST_INTER_1</td>
<td></td>
<td>big birdseye.V.CUST_INTER_1</td>
</tr>
<tr>
<td>Answer Path</td>
<td>Optional. If the non-spatial information will be taken from a different answers page, then the location of that answer page must be specified here.</td>
<td></td>
</tr>
<tr>
<td>Legend Label</td>
<td>Optional. Used to override a legend label.</td>
<td></td>
</tr>
<tr>
<td>Force Legend Icon Height</td>
<td>Optional. Used to override the legend height of a legend icon.</td>
<td></td>
</tr>
<tr>
<td>Force Legend Icon Width</td>
<td>Optional. Used to override the legend width of a legend icon.</td>
<td></td>
</tr>
<tr>
<td>Point Based</td>
<td>If a theme is a point, then this attribute must be set to “Y”.</td>
<td>Y or N</td>
</tr>
<tr>
<td>Legend Selected</td>
<td>If you want a theme’s check box to be selected by default, set this attribute to “Y”.</td>
<td>Y or N</td>
</tr>
<tr>
<td>Icon Offset</td>
<td>Used for point based themes. To offset the location of a point in a map, define the offset values in this attribute.</td>
<td><code>&lt;x coordinate&gt;,&lt;y coordinate&gt;</code></td>
</tr>
<tr>
<td>Example: <code>-15,-15</code></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Filter Columns and Filter Values

If certain answer values need to be filtered in the map, then these two attributes must be defined. The filter Column attribute should contain a set of || delimited answer column names that will be used for filtering. The filter Value will then contain a || delimited set of values as the filter data. Note that the number of columns defined in the filter Column attribute should be the same as the number of values in the filter Value. To change the condition used for filtering, put a >,<,\(\leq\),\(\geq\),\(!=\) symbol in front of the filter Value. By default, filtering uses the \(\leq\) operator.

- **For filter column:**
  \(<\text{answer column to filter1}>||<\text{answer column to filter2}>||<\text{answer column to filter3}>\ldots\)

- **For filter value:**
  \(<\text{filter value 1}>||<\text{filter value 2}>||<\text{filter value 3}>\ldots\)

**Example:**
```
parm1['filterColumn'] = 'Device Typesetters';
parm1['filterValue'] = 'att_transformer||OHIO';
```

If you want to use the OBIEE prompt filter values, then you can define the following, provided that the dev_type and event_state presentation variables have been set for the prompts:
```
parm1['filterColumn'] = 'Device Type||State';
parm1['filterValue'] = '@{dev_type}||@{event_state}'
or
parm1['filterColumn'] = 'Device Type||number of customers';
parm1['filterValue'] = '!=@{dev_type} ||>20';
```

### Visibility Level

Optional. Contains the default minimum and maximum visibility zoom level.

- **Example:** '2-9'

If only one value is assigned, then that is treated as the minimum zoom level.

- **Example:** '5'

### Legend Label

Optional. Used to override the legend title.

### Drill Column 1, DrillColumn 2, Drill Column 3

Optional. If you want to define a drill down, then this attribute must be defined. This column should contain the answer column that will have a drill down value. \(<n>\) is an incremental integer starting from 1 to \(n\). This means you can define as many drill columns in a theme.

<table>
<thead>
<tr>
<th>Parameter Attribute</th>
<th>Description</th>
<th>Value Syntax</th>
</tr>
</thead>
</table>
| Filter Columns and Filter Values      | If certain answer values need to be filtered in the map, then these two attributes must be defined. The filter Column attribute should contain a set of || delimited answer column names that will be used for filtering. The filter Value will then contain a || delimited set of values as the filter data. Note that the number of columns defined in the filter Column attribute should be the same as the number of values in the filter Value. To change the condition used for filtering, put a >,<,\(\leq\),\(\geq\),\(!=\) symbol in front of the filter Value. By default, filtering uses the \(\leq\) operator. | For filter column: \(<\text{answer column to filter1}>||<\text{answer column to filter2}>||<\text{answer column to filter3}>\ldots\) For filter value: \(<\text{filter value 1}>||<\text{filter value 2}>||<\text{filter value 3}>\ldots\) Example: `parm1['filterColumn'] = 'Device Typesetters';
parm1['filterValue'] = 'att_transformer||OHIO';` If you want to use the OBIEE prompt filter values, then you can define the following, provided that the dev_type and event_state presentation variables have been set for the prompts: `parm1['filterColumn'] = 'Device Type||State';
parm1['filterValue'] = '@{dev_type}||@{event_state}'` or `parm1['filterColumn'] = 'Device Type||number of customers';
parm1['filterValue'] = '!=@{dev_type} ||>20';` |
<p>| Visibility Level                      | Optional. Contains the default minimum and maximum visibility zoom level. | (&lt;\text{min zoom level}&gt;-&lt;\text{max zoom level}&gt;) Example: '2-9' If only one value is assigned, then that is treated as the minimum zoom level. Example: '5' |
| Legend Label                          | Optional. Used to override the legend title.                              |                                                                              |
| Drill Column 1, DrillColumn 2, Drill Column 3 | Optional. If you want to define a drill down, then this attribute must be defined. This column should contain the answer column that will have a drill down value. (&lt;n&gt;) is an incremental integer starting from 1 to (n). This means you can define as many drill columns in a theme. | |</p>
<table>
<thead>
<tr>
<th>Parameter Attribute</th>
<th>Description</th>
<th>Value Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drill Path 1, Drill Path 2, Drill Path 3</td>
<td>Optional. Contains the path of the target page. &lt;n&gt; is an incremental integer starting from 1 to n. This means you can define as many drill paths in a theme.</td>
<td></td>
</tr>
<tr>
<td>Drill Page 1, Drill Page 2, Drill Page 3</td>
<td>Optional. Contains the name of the target tab page &lt;n&gt; is an incremental integer starting from 1 to n. This means you can define as many drill pages in a theme.</td>
<td></td>
</tr>
<tr>
<td>Drill Parameter 1, Drill Parameter 2, Drill Parameter 3</td>
<td>Optional. Contains the parameter table and fields that will be passed to the next page. It is represented by comma delimited &lt;table&gt;.&lt;field name&gt;</td>
<td>&lt;table1&gt;.&lt;field name1&gt;,&lt;table2&gt;.&lt;field name2&gt;,... Example: 'CD_ADDR.UDF1_DESCR,CD_ADDR.UDF2_DESCR'</td>
</tr>
<tr>
<td>Drill Parameter Value 1, Drill Parameter Value 2, Drill Parameter Value 3</td>
<td>Optional. Contains the answer column name equivalent of what was defined in drillParameter&lt;n&gt;. The format is comma delimited answer column name.</td>
<td>&lt;answer column1&gt;,&lt;answer column2&gt;,... Example: 'Postal Descr, Customer Interrupted'</td>
</tr>
<tr>
<td>Drill Drop Down 1, Drill Drop Down 2, Drill Drop Down 3</td>
<td>Optional. This is set to “Y” if you opt to display a drop-down of the drill down location instead of a link.</td>
<td>Y or N</td>
</tr>
<tr>
<td>Playback Start Date and Playback Expiry Date</td>
<td>Optional. If the theme has a start and expiry date, then the start and expiry fields from the answers can be provided in these fields in order to assist in playback.</td>
<td></td>
</tr>
<tr>
<td>Display Analytic Column</td>
<td>Optional. Used to display or to hide the column value select drop down. If not selected, then the column select drop-down is available by default. Note that the column select drop-down is only present on the first defined theme.</td>
<td>Y or N</td>
</tr>
</tbody>
</table>
When creating weather themes, the combination of options types will vary with the type of weather theme being created. For instance, weather radar and weather forecast use a different set of option types. The different option types are described in the sections that follow.

**Radar Theme**

<table>
<thead>
<tr>
<th>Parameter Attribute</th>
<th>Description</th>
<th>Value Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>specialStyleColumns</td>
<td>Optional. The | delimited columns from OBIEE answers need to be defined in this attribute if the specialStyle has been assigned a value. Each column will be displayed in a slice or bar. Note that this attribute can only accept numeric columns.</td>
<td>&lt;answer column1&gt;|&lt;answer column2&gt;|...</td>
</tr>
<tr>
<td>Special Style Colors</td>
<td>Optional. Specify the color you want for each slice or bar by defining a | delimited set of colors. The color format is #rrggbb. If this is not specified, the default color values are used.</td>
<td>&lt;color1&gt;|&lt;color2&gt;|...</td>
</tr>
<tr>
<td>Accordion Header</td>
<td>Optional. Specify the header name if the theme will contain an accordion header. Note that accordion will group all succeeding themes until it encounters another accordion header.</td>
<td></td>
</tr>
<tr>
<td>Accordion Open</td>
<td>Optional. Specifies whether the accordion is initially open or not. Default value is “Y”.</td>
<td>Y or N</td>
</tr>
</tbody>
</table>

---

**When creating weather themes, the combination of options types will vary with the type of weather theme being created. For instance, weather radar and weather forecast use a different set of option types. The different option types are described in the sections that follow.**
LegendLabel Optional. Used to override a legend label.

accordionHeader Optional. Specify the header name if the theme will contain an accordion header. Note that accordion will group all succeeding themes until it encounters another accordion header.

accordionOpen Optional. Specifies whether the accordion is initially open or not. Default value is “Y”.

Lightning Strikes Theme

<table>
<thead>
<tr>
<th>Parameter Attribute</th>
<th>Description</th>
<th>Value Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>legendSelected</td>
<td>If you want a theme's check box to be selected by default, set this attribute to “Y”.</td>
<td>Y or N</td>
</tr>
</tbody>
</table>
| visibilityLevel     | Optional. Contains the default minimum and maximum visibility zoom level. | <min zoom level>-<max zoom level> Example: '2-9'
If only one value is assigned, it is treated as the minimum zoom level.
Example: '5'
If this attribute is not specified, the default value used for Lightning is '7-19'.

Note: Oracle recommends against using a very low zoom level. Since the map will only render up to 200 lightning strikes on the screen, some lightning strikes may not be displayed when using a very low zoom level.

legendLabel Optional. Used to override a legend label.
### Forecast Stations Theme

<table>
<thead>
<tr>
<th>Parameter Attribute</th>
<th>Description</th>
<th>Value Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>accordionHeader</td>
<td>Optional. Specify the header name if the theme will contain an accordion header. Note that an accordion will group all succeeding themes until it encounters another accordion header.</td>
<td></td>
</tr>
<tr>
<td>accordionOpen</td>
<td>Optional. Specifies whether the accordion is initially open or not. Default value is “Y” (open).</td>
<td>Y or N</td>
</tr>
<tr>
<td>legendSelected</td>
<td>If you want a theme’s check box to be selected by default, set this attribute to “Y”.</td>
<td>Y or N</td>
</tr>
<tr>
<td>visibilityLevel</td>
<td>Optional. Contains the default minimum and maximum visibility zoom level.</td>
<td>&lt;min zoom level&gt;-&lt;max zoom level&gt;</td>
</tr>
<tr>
<td></td>
<td>Example: ’2-9’</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If only one value is assigned, it is treated as the minimum zoom level.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example: ’5’</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If this attribute is not specified, the default value used for Lightning is: ’7-19’.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>See the note for visibilityLevel in the previous table.</td>
<td></td>
</tr>
<tr>
<td>awsLegendSelected</td>
<td>Optional. Indicates whether the legend checkbox for the aws station will be initially selected by default.</td>
<td>Y or N</td>
</tr>
<tr>
<td></td>
<td>If not specified then the default value is Y.</td>
<td></td>
</tr>
<tr>
<td>Parameter Attribute</td>
<td>Description</td>
<td>Value Syntax</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>awsWithCamLegendSelected</td>
<td>Optional. Indicates whether the legend checkbox for the aws with camera station will be initially selected by default.</td>
<td>Y or N</td>
</tr>
<tr>
<td></td>
<td>If not specified then the default value is Y.</td>
<td></td>
</tr>
<tr>
<td>nwsLegendSelected</td>
<td>Optional. Indicates whether the legend checkbox for the nws station will be initially selected by default.</td>
<td>Y or N</td>
</tr>
<tr>
<td></td>
<td>If not specified then the default value is Y.</td>
<td></td>
</tr>
<tr>
<td>awsLegendLabel</td>
<td>Optional. Used to override the legend label.</td>
<td></td>
</tr>
<tr>
<td>awsWithCamLegendLabel</td>
<td>Optional. Used to override the legend label.</td>
<td></td>
</tr>
<tr>
<td>nwsLegendLabel</td>
<td>Optional. Used to override the legend label.</td>
<td></td>
</tr>
<tr>
<td>accordionHeader</td>
<td>Optional. Specify the header name if the theme will contain an accordion header. Note that an accordion will group all succeeding themes until it encounters another accordion header.</td>
<td></td>
</tr>
<tr>
<td>accordionOpen</td>
<td>Optional. Indicates whether the accordion is initially open or not. Default value is “Y” (open).</td>
<td>Y or N</td>
</tr>
</tbody>
</table>
Configuring Column, Table, and Report Labels

This section provides information on configuring Column, Table, and Report Labels. Labels are configured using the Admin tool in Oracle Utilities Business Intelligence.

Table Labels

Table labels refer to the Facts and Dimension table.

To modify the labels, go to **Menu > Admin Menu > T > Table** and search for the table name. The description field, shown in the following figure, is the label for the table.

![](image)

Column Labels

Column labels refer to the field of the table. For example, in the CF_CUST_RECENT_OUTG table, there is a field name BEGIN_DTTM.

To change the label for that table, specify the label (or a description) in the Label or Override Label input box, as shown in the following figure:

![](image)
Report Labels

Report labels that appear on the answer's title. To configure the report label.

1. Define a report label field in Admin Tool:
   - In Oracle Utilities Business Intelligence, go to **Menu > Admin Menu > F > +Field** (for adding a new field for report label).
   - Enter the necessary information, and then click **Save**. See the following sample screens.

2. To use the newly created field as report label, go to the necessary Answer page in Oracle Business Intelligence Enterprise Edition (OBIEE).

3. Go to the **Result** tab, then choose a result view as “Title”.

4. Enter the following code in Title field:
   
   ```
   (@{biServer.variables['NQ_SESSION.RPT_OUTAGE_MAP']})
   ```

The following figure shows the Title field as it should be populated:
Setting up a Third-Party Base Map

Oracle Utilities Advanced Spatial and Operational Analytics provides support for Oracle eLocation base maps. No setup is required for Oracle eLocation.

The Oracle Utilities Analytics map is capable of rendering tiles from third-party map sources. The following third-party base maps are supported:

- Microsoft Bing Maps
- Google Maps

Note that the product is delivered without any pre-configured API keys for gaining access to these third-party maps. The first step in configuring a third-party base map is to acquire the necessary API keys from the third party sources. Visit the Google or Bing website for more information on generating API keys.

After acquiring the keys for Google or Bing, the only thing left to do is to update the necessary Map Attribute Profile option types, as shown in the following figure:

For Bing

The Map Attribute Profile option types for Bing are listed below:

<table>
<thead>
<tr>
<th>Option Type</th>
<th>Option Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bing Map Source</td>
<td><a href="http://ecn.dev.microsoft.com/mapcontrol/mapcontrol.ashx?v=6.2">http://ecn.dev.microsoft.com/mapcontrol/mapcontrol.ashx?v=6.2</a></td>
</tr>
<tr>
<td>Bing Map API Key</td>
<td>&lt;API Key&gt;</td>
</tr>
<tr>
<td>User Third Party Map Type</td>
<td>aerial, hybrid, road, shaded</td>
</tr>
<tr>
<td>User Third Party Map</td>
<td>bing</td>
</tr>
</tbody>
</table>
For Google

The Map Attribute Profile option types for Google are listed below:

<table>
<thead>
<tr>
<th>Option Type</th>
<th>Option Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Google Map Source</td>
<td><a href="http://maps.google.com/maps?file=api@v=2">http://maps.google.com/maps?file=api@v=2</a></td>
</tr>
<tr>
<td>Google Map API Key</td>
<td>&lt;API Key&gt;</td>
</tr>
<tr>
<td>User Third Party Map Type</td>
<td>aerial, hybrid, physical</td>
</tr>
<tr>
<td>User Third Party Map</td>
<td>google</td>
</tr>
</tbody>
</table>

Importing Map Data from Shapefile

This section describes how to import map data from a shapefile using Map Builder. A shapefile, also referred to as an ESRI Shapefile, is a geospatial vector data format for mapping data.

A theme is basically a map layer. A map is typically composed of multiple themes stacked on top of each other. For example, an application that manages mobile crews might support themes for service area boundaries, crew locations, and work order locations.

To import a shapefile, follow these steps:

1. Start MapBuilder.
2. Select Import Shapefile from the Tools menu. The initial Import Shapefile wizard screen appears. This wizard will take you step-by-step through the process of converting your map data for use with MapViewer.
3. Click Next to begin.
4. Specify the Table name, Geometry Column name, SRID and location of the shapefile, then click Next.
5. Specify the name and style associated with the new theme, then click Next.
   
   Note: If you don't know the name and style of the theme, you can skip this step and specify a theme manually after the import has completed.

   A summary screen displays detailed information on how Map Builder will convert the content of the specified shapefile.
6. Click Finish. The conversion process begins. The system creates a geometry table and populates it with data from the shapefile.
7. If you have more than one shapefile associated with the same theme, repeat the procedure above for each shapefile. Use the same Table name, Geometry Column name and SRID. The system will display a pop-up window, prompting you to either replace the existing data or append the new data to the existing records. Choose Append to add the new data to the data already imported.
8. After all data has been imported, you can preview the data by clicking the Preview tab and then clicking to refresh the preview.
Adding the Theme to the Base Map

Use this procedure to add the new theme to the base map.

1. Open the base map.
2. Click the Editor tab.
3. Click + to add a row for the new theme.
4. To adjust the attribute values for the newly added theme map, highlight the row for the theme and click .
5. Edit the properties as desired and save.
6. To preview the base map, click the Preview tab and then click to refresh the preview.

Flush the Map Cache

Before you can begin using the modified base map, you must flush the map cache as described in the following procedure:

1. Click the Admin button on the top of MapViewer's home page to log in.
2. Click the Management tab.
3. Choose Manage MapViewer, then select Datasources.
4. Click the Purge cached metadata button.
5. To verify the map changes, go to the Map zone that references the modified base map.

Configuring Weather Bug Data

Weather Bug is a third-party organization that can feed weather information, such as weather forecasts, radar information, and lightning strikes. Since it is a third-party provider, access keys need to be acquired, as described earlier for setting up third-party base maps from Google or Bing.

Two Weather Bug keys needed:

- API Key
- PID Key

Note: For more information on how to get these keys, visit the Weather Bug website.

After acquiring the keys, define the following options types in the Map Attribute Profile of the Admin Module:

<table>
<thead>
<tr>
<th>Option Type</th>
<th>Option Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weather Bug PID Key</td>
<td>&lt;PID Key&gt;</td>
</tr>
<tr>
<td>Weather Bug API Key</td>
<td>&lt;API Key&gt;</td>
</tr>
</tbody>
</table>
The Map Attribute Profile screen for Attribute Profile Options is shown below:

Once you have provided the keys, the Radar, Forecast Stations and Lightning Strikes on the map should be accessible.

### Spatial Configuration

This section contains information related to configuring Oracle Utilities Advanced Spatial Outage Analytics. It includes the following topics:

- Installing US State Spatial Data
- Installing US City Spatial Data
- Installing US Zip Code Spatial Data
- Installing US County Spatial Data
- Configuring NMS Device Spatial Data
- Loading Spatial Metadata

### Installing US State Spatial Data

There are various versions of the world sample dataset. These instructions assume that you are using the version with a `world_sample2010.dmp` file. If you have a different version, then these instructions may not work and you should refer to the README included in the downloaded `world_sample.zip` file.

These instructions also assume that the sample data will be loaded into the DWADM account, used for the Data Warehouse. If you want to follow the instructions in the world sample README file instead, then the data will be loaded into a WORLDSAMPLE account, and steps will need to be changed to use that account instead of DWADM.

Use the following procedure to install the World Sample data:

1. Create a work directory on your machine for the data, and change directory to the new directory. For example:

   ```
   mkdir NAVTEQ
   cd NAVTEQ
   ``

2. Unzip the `world_sample.zip` file you downloaded to the new directory. For example:

   ```
   unzip world_sample.zip
   ``

3. Connect to SQLPLUS using DWADM, and remove the old Tables (if present). For example:
sqlplus dwadm/dwadm@database @cln_sample_data.sql

4. Import the world sample dump file into the DWADM account. For example:

   imp dwadm/dwadm@database file=world_sample2010.dmp
   log=world_sample.log full=y

5. After importing the world sample dump file, create the MapViewer Spatial metadata using the following insert statements:

   sqlplus dwadm/dwadm@database
   INSERT INTO user_sdo_maps SELECT * FROM sdo_maps;
   INSERT INTO user_sdo_themes SELECT * FROM sdo_themes;
   INSERT INTO user_sdo_styles SELECT * FROM sdo_styles;
   INSERT INTO user_sdo_cached_maps SELECT * FROM sdo_cached_maps;

6. Create the State spatial table and metadata are used by the default themes present in the OUASA metadata. This assumes that the eLocation web site is being used as the base map. If some other base map is used, then the transform parameter will need to specify the SRID of the base map being used.

   sqlplus dwadm/dwadm@database
   create table q1_states54004 (
       feature_id number, 
       feature_name varchar2(255), 
       area_id number, 
       name_langcode varchar2(35), 
       feature_type varchar2(30), 
       country_code_3 varchar2(5), 
       geometry SDO_GEOMETRY, 
       carto_id number(10,0));

   insert into q1_states54004
   select null, name, null, lang_code, feature_type, 
       ISO_COUNTRY_CODE, sdo_cs.transform(geometry, 54004), 
       carto_id
   FROM wom_area
   WHERE feature_type = 909996
   and iso_country_code = 'USA';

   create index q1_STATES54004_sdx 
   on q1_STATES54004(geom)
   indextype is mdsys.spatial_index;

7. Verify that the following Map Theme Profile labels match the current label for the UDF4_DESCR field in the CD_ADDR table:

   - B1-002-THEME (Customer Interrupted by State Theme) - Filter Columns and Geographical Key Column

---

**Installing US City Spatial Data**

US City shape data is available in the World Sample Data set, however, only the three hundred largest cities are available there. There is sample data available at the US Census bureau for each US State, here:


The following steps can be used to load the sample data for the state of Ohio, and similar steps can be followed to load city data for other US states.
1. Click on the Ohio Zip Code in Shapefile format and download the zt39_d00_shp.zip file to the NAVTEQ directory created in the previous procedure.

2. Unzip the pl39_d00_shp.zip file to the NAVTEQ directory.

3. Start MapBuilder. This is installed when MapViewer is installed. Refer to the MapViewer documentation for instructions on installing and running MapBuilder.

4. If a connection is not created, then select File -> New Connection, and create a connection to the DWADM account in the OUBI Data Warehouse Database.

5. Select Tools -> Import Shapefile, and click Next.

6. Click the Shapefile button.

7. Browse to the C:\NAVTEQ directory, select the pl39_d00_shp.shp file, and click Open.

8. Click Next.

9. Make sure the Create Predefined Theme box is unchecked, and click Next.

10. Review the Summary information and click Finish.

11. Create the Q1_CITY54004 table using the following SQL statement. This assumes that the eLocation web site is being used as the base map. If some other base map is used, then the transform parameter will need to specify the SRID of the base map being used.

```sql
sqlplus dwadm/dwadm@database
create table Q1_CITY54004 as
select upper(name) FEATURE_NAME,
      sdo_cs.transform(geometry, 54004) geometry,
      'OHIO' state
From pl39_d00
Where lsad_trans in ( 'city', 'village' );
create index Q1_CITY54004_sdx
  on Q1_CITY54004 (geometry)
  indextype is mdsys.spatial_index;
UPDATE q1_city54004
  SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);
```

12. Verify that the following Map Theme Profile labels match the current label for the UDF3_DESCR field in the CD_ADDR table:

- B1-001-THEME (Customer Interrupted By Postal Code Theme) - Geographical Key Column
- B1-004-THEME (Monthly Customer Interrupted Playback Theme) - Geographical Key Column
- B1CUSTPTHEME (Customer Interrupted Playback Theme) - Geographical Key Column
- B1CUSTTHEME (Customer Interrupted Theme) - Geographical Key Column

### Installing US Zip Code Spatial Data

Sample shape files for US Zip Code Areas can be found at the following location:

http://www.census.gov/geo/www/cob/z52000.html

The following steps can be used to load the sample data for the state of Ohio, and similar steps can be followed to load zip code data for other US states.
Installation

1. Click on the Ohio Zip Code in Shapefile format and download the zt39_d00.shp.zip file to the NAVTEQ directory created in the previous procedure.
2. Unzip the zt39_d00.shp.zip file to the NAVTEQ directory.
3. Start MapBuilder. This is installed when MapViewer is installed. Refer to the MapViewer documentation for instructions on installing and running MapBuilder.
4. If a connection is not created, then select File -> New Connection, and create a connection to the DWADM account in the OUBI Data Warehouse Database.
5. Select Tools -> Import Shapefile, and click Next.
6. Click the Shapefile button.
7. Browse to the C:\NAVTEQ directory, select the zt39_d00.shp file, and click Open.
8. Click Next.
9. Make sure the Create Predefined Theme box is unchecked, and click Next.
10. Review the Summary information and click Finish.

11. Create the Q1_USZIP54004 table using the following SQL statement. This assumes that the eLocation web site is being used as the base map. If some other base map is used, then the transform parameter will need to specify the SRID of the base map being used.

```
sqlplus dwadm/dwadm@database
create table q1_USZIP54004 as
select zcta ZCTA5CE,
    sdo_cs.transform(geometry, 54004) geom
From ZT39_D00;
create index q1_USZIP54004_sdx
on q1_USZIP54004 (geom)
indextype is mdsys.spatial_index;
UPDATE q1_uszip54004
SET geom = SDO_UTIL.RECTIFY_GEOMETRY(geom, .05);
```

12. Verify that the following Map Theme Profiles are set like this:
   - B1CITYTHEME (Customer Interrupted By City Theme) -
   - Geographical Key Column - City||Label for CD_CITY.STATE field
   - B1-003-THEME (Customer Interrupted By City Theme) -
   - Geographical Key Column - City||State

Installing US County Spatial Data

Sample shape files for US Counties can be found at the following location:

http://www.census.gov/geo/www/cob/z52000.html

The following steps can be used to load the sample data for the state of Ohio, and similar steps can be followed to load county data for other US states.

1. Click on the Ohio County in Shapefile format and download the co39_d00.shp.zip file to the NAVTEQ directory created in the previous procedure.
2. Unzip the co39_d00.shp.zip file to the NAVTEQ directory.
3. Start MapBuilder. This is installed when MapViewer is installed. Refer to MapViewer documentation for instructions on installing and running MapBuilder.
4. If a connection is not created, then select **File -> New Connection**, and create a connection to the DWADM account in the OUBI Data Warehouse Database.

5. Select **Tools -> Import Shapefile**, and click **Next**.

6. Click the Shapefile button.

7. Browse to the C:\NAVTEQ directory, select the co39_d00_shp.shp file, and click **Open**.

8. Click **Next**.

9. Make sure the Create Predefined Theme box is unchecked, and click **Next**.

10. Review the Summary information and click **Finish**.

11. Create the Q1_COUNTY54004 table using the following SQL statement. This assumes that the eLocation web site is being used as the base map. If some other base map is used, then the transform parameter will need to specify the SRID of the base map being used.

   ```sql
   sqlplus dwadm/dwadm@database
   create table q1_COUNTY54004 as
   select name FEATURE_NAME,
           sdo_cs.transform(geometry, 54004) geometry,
           'OHIO' state
   From CO39_D00;
   
   create index q1_COUNTY54004_sdx
   on q1_county54004 (geometry)
   indextype is mdsys.spatial_index;
   
   UPDATE q1_county54004
   SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);
   
   Note: No predefined reports make use of the County data, so if county spatial reports are desired, the Q1_COUNTY_54004 theme will need to be used in new requests and maps.
   ```

### Configuring NMS Device Spatial Data

There are several ways that the geometry data in the DIAGRAM_OBJECTS NMS device table can be accessed by the OUASA Mapping reports. This section lists two of these options.

#### Replicating the DIAGRAM_OBJECTS Table

The easiest option is to replicate the DIAGRAM_OBJECTS table into the OUASA database. If this is done, then after replicating the DIAGRAM_OBJECTS table, the following steps will setup the OUASA dashboards to use the data in this replicated table.

1. Make sure that the spatial index is created on the LL_GEOMETRY column. The LL_GEOMETRY column by default stores spatial data using SRID 54004, so this will work without changes with the eLocation base map:

   ```sql
   create index q1_DIAGRAM_OBJECTS_sdx
   on diagram_objects (ll_geometry)
   indextype is mdsys.spatial_index;
   
   UPDATE diagram_objects
   SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);
   ```

2. Create the required Spatial Metadata:

   ```sql
   INSERT INTO user_sdo_geom_metadata
   VALUES ( 'DIAGRAM_OBJECTS','LL_GEOMETRY',
            MDSYS.SDO_DIM_ARRAY( 
```
3. In MapBuilder, use duplicate to create a copy of the Q1_THEME_DIAGRAMOBJ_54004 Geometry Theme, with the following settings:
   • New Name: DIAGRAM_OBJECTS_54004
   • Target Database: OUASA Database
   • Base Table: DIAGRAM_OBJECTS
   • Spatial Column: LL_GEOMETRY

4. In the Map Admin Module, update these Map Themes, setting the Theme Name to DIAGRAM_OBJECTS_54004:
   • B1CREWTHEME
   • B1EVENTTHEME

**Accessing the NMS Spatial Data Using a Database Link**

If it is not possible to replicate the DIAGRAM_OBJECTS table, and no existing NMS Geometry theme can be used, then it is possible to access the DIAGRAM_OBJECTS table in the OUASA database using a database link. The following steps can be followed to set this up:

1. Create a database link in the OUASA database pointing to the NMS database.
2. Create a synonym DIAGRAM_OBJECTS for the DIAGRAM_OBJECTS table in the NMS database.
3. Update the mapViewerConfig.xml to add another datasource, pointing to the NMS database, just like the OUASA datasource was added earlier in the install documentation.
4. Restart WebLogic to make the NMS database available.
5. Create the required Spatial Metadata in the OUASA database:

   ```sql
   INSERT INTO user_sdo_geom_metadata
   VALUES ( 'DIAGRAM_OBJECTS','LL_GEOMETRY',
           MDSYS.SDO_DIM_ARRAY(           
               MDSYS.SDO_DIM_ELEMENT('LONGITUDE',-180,180,0.05),
               MDSYS.SDO_DIM_ELEMENT('LATITUDE',-90,90,0.05)
           ), 54004);
   ```

6. In MapBuilder, use duplicate to create a copy of the Q1_THEME_DIAGRAMOBJ_54004 Geometry Theme, with the following settings:
   • New Name: DIAGRAM_OBJECTS_54004
   • Target Database: OUASA Database
   • Base Table: DIAGRAM_OBJECTS
   • Spatial Column: LL_GEOMETRY

7. In the Map Admin Module, update these Map Themes, setting the Theme Name to DIAGRAM_OBJECTS_54004:
   • B1CREWTHEME
   • B1EVENTTHEME
Loading Spatial Metadata

This section describes how to load spatial metadata in USER_SDO* tables for Oracle Utilities Oracle Utilities Advanced Spatial Outage Analytics. You can skip this section for Oracle Utilities Outage Analytics (non-spatial).

Before you begin, make sure you have met the following prerequisites:

- Oracle Client 11gR1 or higher client must be installed on the desktop where the database package has been downloaded.
- Check the database connectivity from the desktop.
- Oracle Locator must be installed on the target database.

Perform the following steps in order to load spatial metadata in the target database:

1. Open a command prompt and switch the directory to the 'Spatial-Metadata' folder. For example:
   C:\Database\Spatial-Metadata

2. Import released spatial tables to the target database using following command:

   imp dwadm/dwadm@database-name file=user_sdo.dmp
   log=imp_user_sdo.log parfile=user_sdo_tbls.par

3. Review the imp_user_sdo.log file to ensure the tables were imported successfully.

4. After importing the table, run following SQL scripts from the same folder:

   - sqlplus dwadm/dwadm@database-name @copy_spatial_metadata.sql
   - sqlplus dwadm/dwadm@database-name @clean_sdo_release_tbls.sql

5. Review the log files.

OBIEE Configuration

This section contains information about configuring Oracle Business Intelligence Enterprise Edition (OBIEE) for use with Oracle Utilities Advance Spatial and Operational Analytics. It contains the following topics:

- Setting Up and Configuring User Security
- Managing Content in the Presentation Catalog
- Configuring the Repository (RPD) File
- Loading Catalog Files
Setting Up and Configuring User Security

This section provides information about user security, including catalog groups and users.

Existing Catalog Groups and Users

The existing catalog groups and users are defined below:

- Presentation Server Administrators (the default group)
- Executive Group
  - Users:
    - Administrator
    - Executive
- External Group
  - Users:
    - External
- Media Group
  - Users:
    - Administrator
    - Media
- Supervisor Group
  - Users:
    - Supervisor

Defining New Catalog Groups

The Administrator or a User that belongs to the Presentation Server Administrators Group should have the necessary privileges to define additional User Groups in the Presentation Catalog.

To define new catalog groups, access the following:

BIEE Dashboards -> Settings -> Administration -> Manage Presentation Catalog Groups and Users -> Create a new Catalog Group

Defining New Users

The new User must be defined in the Oracle BI Administration Tool. The Administrator can use the User credentials to log on to the Dashboards with related security Authentication and Authorization privileges.

Once logged on, the User ID appears in the List of Existing Catalog Groups and Users on the BIEE Dashboards -> Settings -> Administration -> Manage Presentation Catalog Groups and Users.

To add the user to the proper group, use the Edit Catalog Group -> Add member option. The corresponding object level security for objects on the Dashboards is inherited from the Catalog Group.
Managing Content in the Presentation Catalog

Oracle Utilities Advanced Spatial and Operational Analytics Presentation Catalog has either Spatial Setup or Non-Spatial Setup, depending on your organization's licenses.

The following folders are available on the Shared Folders in Answers for the Spatial Analytics:

- OUASA Dashboards and Shared Requests
- OUASA Spatial Requests

The following folders are available on the Shared Folders in Answers for the Non-Spatial Analytics:

- OUASA Dashboards and Shared Requests
- OUASA Non-Spatial Requests

The prompts and requests are saved in separate Folders on all the above.

For more information on User Security and Managing Catalog objects please refer to the Oracle Business Intelligence Presentation Services Administration Guide.

Managing Folders and Content

New folders can be created by the customer if new Answers or modifications to existing ones are needed.

To create new folders (or Development Folders), log on to the Presentation Services as an Administrator and access:

Settings -> Administration -> Manage Presentation Catalogs -> Shared Folders -> Create New Folder

Once a new folder is created, the following values can be set:

- Properties
- Edit Name and Description
- Delete
- Permissions
- Copy/Move

The customer can save new Answers onto the development folders, thereby leaving the out-of-box folders as is. Once the Answer is created, the report is written and unit testing is complete, the request can be moved to the common folder.

Editing Names and Descriptions of Objects

To edit names and descriptions of objects, log on to the Presentation Services as an Administrator and access:

Settings -> Administration -> Manage Presentation Catalogs -> Shared Folders
Configuring the Repository (RPD) File

Use this procedure to configure the database connections for spatial and non-spatial databases.

Follow these steps to configure the RPD file.

**Note:** Configuring RPD files requires Oracle Business Intelligence's Administration Tool, which is available only on Windows. If your production system uses Unix or Linux, you will need a Windows installation of OBIEE to be able to perform the following steps.

1. Unzip the contents of the Oracle Utilities Advanced Spatial and Operations Analytics package into a temporary directory (such as $TMP_BIRDSEYE) on the Windows machine where Oracle Business Intelligence is installed.

2. Launch the Administration Tool as follows:

   **Start->Programs->Oracle Business Intelligence->Administration.**

3. Open the RPD file:

   $TMP_BIRDSEYE/b1/Reports/UtilitiesBusinessAnalytics.rpd

4. Enter the User name as Administrator and Password as SADMIN.

5. In the Physical Panel on the right hand side, expand the Oracle Data Warehouse tree.

6. Double-click on OUBI Database Connection.
7. Update the Data Source Name, User Name & Password fields.

8. Click OK.

   Note: Steps 9 to 12 are required only for Oracle Utilities Advanced Spatial Outage Analytics installation. You can skip these if you are using Oracle Utilities Outage Analytics (non-spatial).

9. (Optional) In the Physical panel on the right hand side, expand the Spatial Database tree.

10. (Optional) Double-click the Spatial Connection Pool.
11. (Optional) Update the Data Source Name, User Name & Password fields.

12. (Optional) Click **OK**.

13. Save the RPD file.

14. If this is not your production environment, copy the RPD file to the production machine and place it in $OBIEE_HOME/server/Repository, where $OBIEE_HOME is the location where Oracle Business Intelligence is installed.
Loading Catalog Files

Use the following procedure to load the catalog files.

**Note:** Loading catalog files requires Oracle Business Intelligence's Catalog Manager, which is available only on Windows. If your production system uses Unix or Linux, you will need a Windows installation of OBIEE to be able to perform the following steps.

1. Unzip the contents of the Oracle Utilities Advanced Spatial and Operations Analytics package into a temporary directory (such as $TMP_BIRDSEYE) on the Windows machine where Oracle Business Intelligence is installed.

2. Launch the Catalog Manger as follows:

   **Start->Programs->Oracle Business Intelligence-> Catalog Manager**

3. Select **Open Catalog** from the File Menu. The Open Catalog window is displayed.

4. Specify the following values:
   - From the Type drop-down, select Online.
   - Enter the URL to the analytics web application in the following form:
     ```
     http://<OBIEE Host>:<OBIEE Port>/analytics/saw.dll
     ```
   - Enter Administrator as the User and SADMIN as the Password.
   - Click OK to close the window.

5. In the tree panel, expand the root folder `/`.

6. Click on the Shared folder (as shown above) and select **Unarchive** from the File Menu.

7. Click **Browse** and locate `$TMP_BIRDSEYE/b1/Reports/UtilitiesBusinessAnalytics.catalog`. 

---

1-46 Oracle Utilities Advanced Spatial and Operational Analytics Installation Guide
8. Click **Open**, and then click **OK**.
You are done loading the catalog once you see an Operation Done message.

9. Repeat steps 8-10 with \[\$TMP_BIRDSEYE\]/b1/Reports/UtilitiesBusinessNonSpatialAnalytics.catalog.

10. If you are installing Oracle Utilities Advanced Spatial Outage Analytics, repeat steps 8-10 with \[\$TMP_BIRDSEYE\]/b1/Reports/UtilitiesBusinessSpatialAnalytics.catalog.

### Database Configuration

This section describes information related to database configuration for Oracle Utilities Advanced Spatial and Operational Analytics.

### Creating Materialized Views

The released Answers contain some queries that run against historical tables. As these tables fill up with data, performance will degrade. The answers that are delivered can make use of Materialized views to improve performance.

The following lists the SQL statement that can be used to create sample materialized views.

```
CREATE MATERIALIZED VIEW OUBI_MV_CITY_OUTG_01
BUILD IMMEDIATE
REFRESH FORCE
ENABLE QUERY REWRITE
AS
select upper(T3168.SRC_CITY) as c1,
     T3168.SRC_STATE as c2,
     sum(T4710.SAIDI) as c3,
     sum(T4710.SAIFI) as c4,
     sum(T4710.CAIDI) as c5,
     sum(T4710.MAIFI) as c6,
     sum(T4710.CMI) as c7,
     sum(T4710.CEMI) as c8,
     sum(T4710.CEMSMI) as c9,
     sum(T4710.NUM_CUST_INTRPT) as c10
from
     CD_CITY T3168,
     CF_CITY_OUTG T4710
where
    ( T3168.CITY_KEY = T4710.CITY_KEY )
group by
     T3168.SRC_STATE, upper(T3168.SRC_CITY)

CREATE MATERIALIZED VIEW OUBI_MV_CTRL_ZONE_OUTG_01
BUILD IMMEDIATE
REFRESH FORCE
ENABLE QUERY REWRITE
AS
select T3355.UDF1_DESCR as T3355_UDF1_DESCR,
     T3355.UDF2_DESCR as T3355_UDF2_DESCR,
     T3355.UDF3_DESCR as T3355_UDF3_DESCR,
     T3355.UDF4_DESCR as T3355_UDF4_DESCR,
     T3355.UDF5_DESCR as T3355_UDF5_DESCR,
     sum(T4804.SAIDI) as T4804_SAIDI,
     sum(T4804.SAIFI) as T4804_SAIFI,
     sum(T4804.CAIDI) as T4804_CAIDI,
     sum(T4804.CAI) as T4804_CAI,
     sum(T4804.SAI) as T4804_SAI,
     sum(T4804.CMI) as T4804_CMI,
     sum(T4804.CEMI) as T4804_CEMI,
     sum(T4804.CEMSMI) as T4804_CEMSMI
from
     CD_CTRL_ZONE T3355,
     CF_CTRL_ZONE_OUTG T4804
where
    ( T3355.CITY_KEY = T4804.CITY_KEY )
group by T3355.CITY_KEY
```
```sql
CREATE MATERIALIZED VIEW OUBI_MV_CTRL_ZONE_OUTG_02
BUILD IMMEDIATE
REFRESH FORCE
ENABLE QUERY REWRITE
AS
select T4138.SNAP_TYPE_CD as T4138_SNAP_TYPE_CD,
     T4804.SNAP_TYPE_CD as T4804_SNAP_TYPE_CD,
     sum(T4804.SAIDI) as T4804_SAIDI,
     sum(T4804.SAIFI) as T4804_SAIFI,
     sum(T4804.CAIDI) as T4804_CAIDI,
     sum(T4804.MAIFI) as T4804_MAIFI,
     sum(T4804.CMI) as T4804_CMI,
     sum(T4804.CEMI) as T4804_CEMI,
     sum(T4804.CEMSMI) as T4804_CEMSMI,
     sum(T4804.NUM_CUST_INTRPT) as T4804_NUM_CUST_INTRPT,
     sum(T4804.NUM_EVENT) as T4804_NUM_EVENT,
     sum(T4804.FACT_CNT) as T4804_FACT_CNT,
     sum(T4804.NUM_CUST_SUST_INTRPT) as T4804_NUM_CUST_SUST_INTRPT,
     sum(T4804.NUM_CUST_SERVED) as T4804_NUM_CUST_SERVED,
     sum(T4804.NUM_SUST_INTRPT) as T4804_NUM_SUST_INTRPT
from
    CD_SNAP_TYPE T4138,
    CF_CTRL_ZONE_OUTG T4804
where  T4138.SNAP_TYPE_CD = T4804.SNAP_TYPE_CD
group by T4138.SNAP_TYPE_CD,
        T4804.SNAP_TYPE_CD
```

```sql
CREATE MATERIALIZED VIEW OUBI_MV_CTRL_ZONE_OUTG_03
BUILD IMMEDIATE
REFRESH FORCE
ENABLE QUERY REWRITE
AS
select T4138.SNAP_TYPE_CD as T4138_SNAP_TYPE_CD,
     T4804.SNAP_TYPE_CD as T4804_SNAP_TYPE_CD,
     T3442.UDF5_DESCR as T3442_UDF5_DESCR,
     T3442.CAL_MONTH_NBR as T3442_CAL_MONTH_NBR,
from
    CD_CTRL_ZONE T3355,
    CF_CTRL_ZONE_OUTG T4804
where  ( T3355.CTRL_ZONE_KEY = T4804.CTRL_ZONE_KEY )
group by T3355.UDF1_DESCR, T3355.UDF2_DESCR, T3355.UDF3_DESCR,
       T3355.UDF4_DESCR, T3355.UDF5_DESCR
```

```sql
CREATE MATERIALIZED VIEW OUBI_MV_CTRL_ZONE_OUTG_02
BUILD IMMEDIATE
REFRESH FORCE
ENABLE QUERY REWRITE
AS
select T4138.SNAP_TYPE_CD as T4138_SNAP_TYPE_CD,
     T4804.SNAP_TYPE_CD as T4804_SNAP_TYPE_CD,
     sum(T4804.SAIDI) as T4804_SAIDI,
     sum(T4804.SAIFI) as T4804_SAIFI,
     sum(T4804.CAIDI) as T4804_CAIDI,
     sum(T4804.MAIFI) as T4804_MAIFI,
     sum(T4804.CMI) as T4804_CMI,
     sum(T4804.CEMI) as T4804_CEMI,
     sum(T4804.CEMSMI) as T4804_CEMSMI,
     sum(T4804.NUM_CUST_INTRPT) as T4804_NUM_CUST_INTRPT,
     sum(T4804.NUM_EVENT) as T4804_NUM_EVENT,
     sum(T4804.FACT_CNT) as T4804_FACT_CNT,
     sum(T4804.NUM_CUST_SUST_INTRPT) as T4804_NUM_CUST_SUST_INTRPT,
     sum(T4804.NUM_CUST_SERVED) as T4804_NUM_CUST_SERVED,
     sum(T4804.NUM_SUST_INTRPT) as T4804_NUM_SUST_INTRPT
from
    CD_CTRL_ZONE T3355,
    CF_CTRL_ZONE_OUTG T4804
where  ( T3355.CTRL_ZONE_KEY = T4804.CTRL_ZONE_KEY )
group by T3355.UDF1_DESCR, T3355.UDF2_DESCR, T3355.UDF3_DESCR,
       T3355.UDF4_DESCR, T3355.UDF5_DESCR
```
sum(T4804.SAIDI) as T4804_SAIDI,
sum(T4804.SAIFI) as T4804_SAIFI,
sum(T4804.CAIDI) as T4804_CAIDI,
sum(T4804.MAIFI) as T4804_MAIFI,
sum(T4804.CMI) as T4804_CMI,
sum(T4804.CEMI) as T4804_CEMI,
sum(T4804.CEMSMI) as T4804_CEMSMI,
sum(T4804.NUM_CUST_INTRPT) as T4804_NUM_CUST_INTRPT,
sum(T4804.NUM_EVENT) as T4804_NUM_EVENT,
sum(T4804.FACT_CNT) as T4804_FACT_CNT,
sum(T4804.NUM_CUST_SUST_INTRPT) as T4804_NUM_CUST_SUST_INTRPT,
sum(T4804.NUM_CUST_SERVED) as T4804_NUM_CUST_SERVED,
sum(T4804.NUM_SUST_INTRPT) as T4804_NUM_SUST_INTRPT
from
CD_SNAP_TYPE T4138,
CD_DATE T3442,
CF_CTRL_ZONE_OUTG T4804
where T3442.DATE_KEY = T4804.END_DATE_KEY and
T4138.SNAP_TYPE_CD = T4804.SNAP_TYPE_CD
group by
T4138.SNAP_TYPE_CD,
T4804.SNAP_TYPE_CD,
T3442.UDF5_DESCR, T3442.CAL_MONTH_NBR

CREATE MATERIALIZED VIEW OUBI_MV_CUST_RST_OUTG_01
BUILD IMMEDIATE
REFRESH FORCE
ENABLE QUERY REWRITE
AS
select
T3442.MONTH_END_DT as T3442_MONTH_END_DT,
T2765.UDF1_DESCR as T2763_UDF1_DESCR,
T2765.UDF2_DESCR as T2763_UDF2_DESCR,
T2765.UDF3_DESCR as T2763_UDF3_DESCR,
T2765.UDF4_DESCR as T2763_UDF4_DESCR,
T2765.UDF5_DESCR as T2763_UDF5_DESCR,
T3481.DEVICE_TYPE_DESCR as T3481_DEVICE_TYPE_DESCR,
T3516.UDF9_DESCR as T3516_UDF9_DESCR,
T3516.EVENT_STATE_DESCR as T3516_EVENT_STATE_DESCR,
T3516.EVENT_NBR as T3516_EVENT_NBR,
T3355.UDF1_DESCR as T3355_UDF1_DESCR,
T3355.UDF2_DESCR as T3355_UDF2_DESCR,
T3355.UDF3_DESCR as T3355_UDF3_DESCR,
T3355.UDF4_DESCR as T3355_UDF4_DESCR,
T3355.UDF5_DESCR as T3355_UDF5_DESCR,
T3442.CAL_YEAR AS T3442_CAL_YEAR,
sum(T4889.FACT_CNT) as T4889_FACT_CNT,
sum(T4889.CMI) as T4889_CMI
from
CD_DATE T3442,
CD_ADDR T2765,
CD_EVENT T3516,
CD_CTRL_ZONE T3355,
CD_DEVICE T3481,
CF_CUST_RST_OUTG T4889
where T2765.ADDR_KEY = T4889.ADDR_KEY and
T3442.DATE_KEY = T4889.BEGIN_DATE_KEY and
T3516.EVENT_KEY = T4889.EVENT_KEY and
T3355.CTRL_ZONE_KEY = T4889.CTRL_ZONE_KEY AND
T3481.DEVICE_KEY = T4889.CAUSE_DEVICE_KEY
group by T2765.UDF1_DESCR, T2765.UDF2_DESCR, T2765.UDF3_DESCR,
T2765.UDF4_DESCR, T2765.UDF5_DESCR,
T3442.MONTH_END_DT, T3442.CAL_YEAR,
T3516.EVENT_STATE_DESCR, T3516.EVENT_NBR, T3516.UDF9_DESCR,
T3481.DEVICE_TYPE_DESCR,
T3355.UDF1_DESCR, T3355.UDF2_DESCR, T3355.UDF3_DESCR,
T3355.UDF4_DESCR, T3355.UDF5_DESCR
CREATE MATERIALIZED VIEW OUBI_MV_RST_JOB_01
BUILD IMMEDIATE
REFRESH FORCE
ENABLE QUERY REWRITE
AS
select max(case when T5250.EST_RST_DATE_KEY = 0 then cast(NULL as DATE) else ( CAST( cast(T5250.BEGIN_DTTM as DATE) as DATE) + ( cast((T5250.EST_RST_DATE_KEY - T5250.BEGIN_DATE_KEY) * 24 * 60 * 60 + T5250.EST_RST_TIME_KEY - T5250.BEGIN_TIME_KEY as INTEGER ) / 86400 ) end ) as T5250_TIME_DIFF,
avg(case when T5250.EST_RST_DATE_KEY = 0 then 0 else ROUND( ( CAST( ( CAST( cast(T5250.BEGIN_DTTM as DATE) as DATE) + ( cast((T5250.EST_RST_DATE_KEY - T5250.BEGIN_DATE_KEY) * 24 * 60 * 60 + T5250.EST_RST_TIME_KEY - T5250.BEGIN_TIME_KEY as INTEGER ) / 86400 ) as DATE) - CAST(T5250.RST_DTTM as DATE) ) * 1440 ) end ) as T5250_AVG_TIME,
T3481.DEVICE_TYPE_DESCR as T3481_DEVICE_TYPE_DESCR,
T3516.UDF9_DESCR as T3516_UDF9_DESCR,
T3516.EVENT_STATE_DESCR as T3516_EVENT_STATE_DESCR,
T3516.EVENT_NBR as T3516_EVENT_NBR,
T3355.UDF1_DESCR as T3355_UDF1_DESCR,
T3355.UDF2_DESCR as T3355_UDF2_DESCR,
T3355.UDF3_DESCR as T3355_UDF3_DESCR,
T3355.UDF4_DESCR as T3355_UDF4_DESCR,
T3355.UDF5_DESCR as T3355_UDF5_DESCR,
T3442.CAL_YEAR AS T3442_CAL_YEAR,
T5250.EXCLUDE_IND as T5250_EXCLUDE_IND,
max(T5250.RST_DTTM) as T5250_RST_DTTM,
max(T5250.BEGIN_DTTM) as T5250_BEGIN_DTTM,
sum(T5250.OUTG_DURATION) as T5250_OUTG_DURATION,
sum(T5250.FACT_CNT) as T5250_FACT_CNT
from CD_EVENT T3516,
CD_CTRL_ZONE T3355,
CD_DATE T3442,
CD_DEVICE T3481,
CF_RST_JOB T5250
where T3355.CTRL_ZONE_KEY = T5250.CTRL_ZONE_KEY and
T3516.EVENT_KEY = T5250.EVENT_KEY and
T3442.DATE_KEY = T5250.BEGIN_DATE_KEY and
T3481.DEVICE_KEY = T5250.DEVICE_KEY
group by
T3516.EVENT_STATE_DESCR, T3516.EVENT_NBR, T3516.UDF9_DESCR,
T3481.DEVICE_TYPE_DESCR,
CREATE MATERIALIZED VIEW OUBI_MV_RST_CALL_01
BUILD IMMEDIATE
REFRESH FORCE
ENABLE QUERY REWRITE
AS

select sum(T5184.FACT_CNT) as T5184_FACT_CNT,
   T3516.EVENT_STATE_DESCR as T3516_EVENT_STATE_DESCR,
   T3516.EVENT_NBR as T3516_EVENT_NBR,
   T3355.UDF1_DESCR as T3355_UDF1_DESCR,
   T3355.UDF2_DESCR as T3355_UDF2_DESCR,
   T3355.UDF3_DESCR as T3355_UDF3_DESCR,
   T3355.UDF4_DESCR as T3355_UDF4_DESCR,
   T3355.UDF5_DESCR as T3355_UDF5_DESCR
from
   CD_EVENT T3516,
   CD_CTRL_ZONE T3355,
   CF_RST_CALL T5184
where  ( T3355.CTRL_ZONE_KEY = T5184.CTRL_ZONE_KEY and
         T3516.EVENT_KEY = T5184.EVENT_KEY )
group by
       T3516.EVENT_STATE_DESCR, T3516.EVENT_NBR,
       T3355.UDF1_DESCR, T3355.UDF2_DESCR, T3355.UDF3_DESCR,
       T3355.UDF4_DESCR, T3355.UDF5_DESCR

The materialized views will need to be refreshed anytime the data in the underlying Fact table
(CF*) is updated. Thus, if data is loaded into a Fact table every night, these materialized views
should be refreshed nightly.

If answers are added to the Dashboards, then the queries used by the answers can be determined
by running OBIEE from a user with a logging set to level 2. This will create a log of the queries in
the NQQuery.log file, which is located in the \OracleBI\server\Log directory. The logging level is
set using Security Manager while editing the RPD file. Logging should not be turned on in a
Production environment. For more information on query logging, please refer to the Oracle
Business Intelligence Presentation Services Administration Guide.
Support

Contacting Oracle Support

Please follow this link to contact Oracle Support:

http://www.oracle.com/support/index.html